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Whats On …... General Meeting – Wednesday 4 May 2011 at Buderim
Technology
Education
Centres
Caloundra
Buderim
Yandina

• Get hands on help with all your technology problems.
• Tutorials are presented during each session.
• Internet and Intranet access is available.
Windows, Linux and Apple Mac operating systems are supported.
Every Saturday between 9.00 am and 12.30 pm
Caloundra Youth hall, Queen Street Caloundra, (opposite High School).
Every Wednesday between 9.30 am and 12.00 noon,
Good Life Centre, 100 Buderim Pines Drive, Buderim.
3rd Wednesday of the month between 1.30 pm and 4.00 pm.,
RSL Hall, North Street, Yandina

Notice about SCCC Monthly General Meetings
The SCCC Monthly Meetings alternate between the Caloundra and Buderim venues. In Caloundra the meeting is held on the first
Saturday of the month and in Buderim the meeting is held on the first Wednesday of the alternate month.

The next SCCC Monthly Meeting will be at Buderim on Wednesday 4 May at 11.00 am.
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From The Editor – Judy Smith
Bits'N'Bytes is produced monthly from February to
December each year.
Contributions for the newsletter are always welcome.
Please send copy for the next issue to reach the editor
as early as possible after the monthly meeting or by the
deadline: 23 May, 2011.
Email: editor@sccc.org.au or Snail Mail: The Editor PO
Box 384, Caloundra, Qld 4551.

Membership Cards for Collection - Membership
cards for those members who joined or renewed
membership for the month ending 20 April 2011 are
available for collection at Caloundra and Buderim
meetings. Cards that have not been collected in the
previous twelve months are also available.
Note - Membership cards show the next renewal date
of membership.

This magazine is created with OpenOffice and
produced in printed form and also electronically
in PDF format.
Copyright - material in this newsletter may be copied
in other publications provided that copyright rests with
the Sunshine Coast Computer Club Inc., This permission
is on condition that reference is made to SCCC (with
original published date) in the reprinted item.
Liability - Although articles in this newsletter are
checked for content, no warranty can be given for any
loss resulting from the use of material in the newsletter.
Articles and advertisements are printed in good faith
and views and opinions are not necessarily those held
by the club.

Learn to Use Computers at the
Sunshine Coast Libraries
Free computer tutorials and demonstrations
available at the Libraries on the Sunshine Coast.

are

Bookings are required for all sessions. Please contact
the library branch in your area for details.
Note: You can also learn online at home or in the
library.

SCCC Privacy Statement - In joining the Sunshine
Coast Computer Club please note that it is a club
operated by volunteer members and operating within
the community involving many activities relating to
meetings, instructional and social functions for
members and at times visitors.
This requires the keeping of a member data base and
the publication of the names of new members. The
Club guards the member data base as best as possible
and does not publish member's addresses nor
telephone numbers unless authorised.
At times photographs are taken at meetings and
functions and are sometimes published. Should you
have any problems relating to your personal privacy
which arises or is likely to arise, it is your duty and
responsibility to advise the Club secretary in writing of
the circumstances and requirements.
What's on Bulletin - What's On Bulletins are sent once
a week, generally on a Monday afternoon, to all members
who have provided the Club with their email address.
These bulletins give details of up-coming tutorials and
topics to be covered at the various meeting venues. You
will also find items of interest and club announcements in
these bulletins.

'HOW TO' Classes
Office works conducts free 'HOW TO' classes on
Saturday and Sunday at 11am
Sessions are free but spaces are limited
See Officeworks for details or visit
www.officeworks.com.au/ims_docs/static/ht_quee
nsland.pdf
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Reports
Treasurer's Report
Profit and Loss
Cash Basis 21 March 2011 – 20 April 2011
Income
Fundraising
Interest Received
Meetings
Membership fees
Sales
Software
Sales – Other
Total Sales
Total Income

Minutes of the SCCC General Meeting
Held at the Caloundra Community Youth Hall
2nd April 2011
Meeting: Commenced 11.15 am

608.91
0.37
3,030.55
2,086.96
35.00
35.00
70.00
5796.79

Expense
Administration
Hall Hire
Internet Service Provider
Phone
Postage
Printing/Stationery
Refreshments
Travel Reimbursement
Total Expense

600.00
1,208.50
169.80
126.83
132.13
232.73
539.60
35.52
3,045.11

Net Income

2,751.68

Apologies: Jim McGregor, Andrew Hadland.
Minutes of Previous Meeting: No Business arising
from the previous months minutes.
Motion proposed by Ian Smyth that the previous
months minutes be accepted was Seconded by Steve
Tottszer. CARRIED
New Members: Elizabeth Benedict, Rob Coles, Gerry
Craig, Roohi Doherty, Joan Edwards,
John Elliott, Ron 2598 Erbacher, Jeremy Masters, Dave
Murray, Jan Richards, Madeline Stoopin,
Karin Svensson, Gayle Tomlinson.
Treasurers Report; Leo Kavanagh presented the
Treasurers report for the period 21/02/11to 20/03/11
Total income of $5,271.03 and net income of 2,227.54,
There was no unusual spending this month, the clubs'
insurance will be in next months report. Any members
wanting a more detailed report may request this from
our treasurer Leo Kavanagh.
Leo Kavanagh proposed that the Treasurer's Report be
Accepted, this was Seconded by Edgar Telford.
CARRIED
General Business : Peter asked if any members had
any business to discuss, , he declared the meeting
closed at 11.20am
Marie McGregor (Secretary)
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Fukushima, and Safe Radiation Levels - Peter Daley
Fukushima, and Safe Radiation Levels, by Peter
Daley (Opinion)
Radiation is all around us, sun light, in concrete floors
and house bricks. There is a level of background
radiation constantly around us in our environment. I am
comfortable with that. When a level 7 nuclear disaster
like Fukushima has the potential to raise my natural
radioactive environment significantly to a new level,
then I pay attention.
If you have been watching the main stream
news media TV or print, you will not know the
full story! The main stream press has gone quiet on
the Fukushima nuclear disaster, but the situation at
Fukushima is dynamic, and changing. I feel it is
important to keep informed on this disaster because of
it potential long term effects. It looks like it could go on
for months. It now has the highest Nuclear Accident
event rating, Level 7. Some experts said it should have
been put on this level weeks ago.
Radiation fallout from Fukushima is not directly
affecting us here in Australia at present, but there has
been wide spread fallout of numerous radioactive
isotopes in the Northern hemisphere at reportedly low
levels at present. The highest concentrations of
radioactive fallout appear to have fallen over, Japan,
Northern China, North and South Korea, Alaska, and
the west coast of America, and Canada, plus lots over
the Pacific Ocean. It all depends on the wind directions
and what level and type of radioactive material is
leaking from the Fukushima Nuclear plant at the time. A
lot of radioactive water has been dumped, or spilled
into the Pacific Ocean near the plant, plus radioactive
fallout is still falling on the Pacific Ocean.
Here is a video of a projected fallout cloud on the west
coast of America on the 24th April
The biggest health risks seems to be the concentration
of radioactive isotopes from the radiation fallout
through the food chain in milk, meat and fish. The
Geiger counter readings of local background radiation
levels will not give you any indication of the
concentrations of these isotopes in any given food item.
You really need governments to test for that.
If this report is correct the Japanese government has
presently set 20 millisieverts per year as a safe limit for
background radiation exposure in Japan. Professor
Toshiso Kosako was appointed by the Japanese
government on March 16th and was given the position
because the Japanese Government said he possessed
outstanding insight and expertise in the field of
radiation safety. On April 29th an emotional Toshiso

Kosako resigned in protest, saying the government
quietly raised the radiation safety level to 20
millisieverts per year, and this is 20 times too high,
especially for children. Children are considered more
vulnerable to radiation than adults. Governments seem
to quietly raised the so called safe radiation levels when
disasters like this occur.
http://enenews.com/childs-risk-cancer-radiation-10100-times-higher-adult-same-exposure-video
Call me cynical, but I have no faith in governments, or
corporations providing truthful information in disasters
like Fukushima. Research I have done constantly shows
Governments
and
Corporations
changing
the
information to protect the financial interests of the
corporation involved, or the government's political
interests at the time, to the detriment of the health and
well being of their citizens. In other words they will
sacrifice you on the alter to their Gods, money and
power.
Radiation fallout does not fall evenly but is distributed
by wind, rain and snow in what are called hot spots.
Area reports of radiation fall out levels very depending
on what organisation collects the information, in some
cases they don't seem to collect it because there is
wide spread test equipment failure. This happened
when a lot of radiation test sites on the west coast of
America went down during radioactive fallout events
created by Fukushima. This makes you suspicious
doesn't it! To make things even more confusing,
different governments and also different organisations
in a given government may have different sets of
radiation safety levels.
If a government can arbitrarily change the so
called radiation safety levels for it citizens, or
different departments in a government have
different safety levels, what is safe?
From the research I have read it would appear that any
increase the background radiation level caused by
Radioactive fallout is not good. Long term low level
radiation can potentially be more dangerous than a
short high dose.
What is far worse though, is breathing in of radioactive
particulate material, or ingesting radioactive isotopes in
food or water. This is likely to produce long term health
effects because the radiation is inside you and close to
cells. Because radioactivity is close to the cells, it is
radiating them with much more intensity when
compared to most background radiation you may be
exposed to!
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10 Tips for Smarter, More Efficient Internet Searching – Bill Maxwell
1: Use unique, specific terms

6: Drop the suffixes

It is simply amazing how many Web pages are returned
when performing a search. You might guess that the
term “blue dolphin” is relatively specialised. A Google
search of those terms returned 2,440,000 results! To
reduce the number of pages returned, use unique
terms that are specific to the subject you are
researching.

It’s usually best to enter the base word so that you
don’t exclude relevant pages. For example, bird and not
birds, walk and not walked. One exception is if you are
looking for sites that focus on the act of walking, enter
the whole term walking.

2: Use the minus operator (-) to narrow the
search
How many times have you searched for a term and had
the search engine return something totally unexpected?
Terms with multiple meanings can return a lot of
unwanted results. The rarely used but powerful minus
operator, equivalent to a Boolean NOT, can remove
many unwanted results. For example, when searching
for the insect caterpillar, references to the company
Caterpillar, Inc. will also be returned. Use Caterpillar
-Inc to exclude references to the company or Caterpillar
-Inc -Cat to further refine the search.
3: Use quotation marks for exact phrases

7: Maximise AutoComplete
Ordering search terms from general to specific in the
search box will display helpful results in a drop-down
list and is the most efficient way to use AutoComplete.
Selecting the appropriate item as it appears will save
time typing. You have several choices for how the
AutoComplete feature works:
Use Google AutoComplete. The standard Google start
page will display a drop-down list of suggestions
supplied by the Google search engine. This option can
be a handy way to discover similar, related searches.
For example, typing in Tucson fast will not only bring up
the suggestion Tucson fast food but also Tucson fast
food coupons.

I often remember parts of phrases I have seen on a
Web page or part of a quotation I want to track down.
Using quotation marks around a phrase will return only
those exact words in that order. It’s one of the best
ways to limit the pages returned. Example: “Be nice to
nerds”. Of course, you must have the phrase exactly
right — and if your memory is as good as mine, that
can be problematic.

Use browser AutoComplete. Use this Google start page
to disable the Google AutoComplete feature and display
a list of your previous searches in a drop-down box. I
find this particularly useful when I’ve made dozens of
searches in the past for a particular item. The browser’s
AutoComplete feature must be turned on for this option
to work. Click one of these links for instructions
detailing how to turn AutoComplete on or off in I.E. and
Firefox.

4: Don’t use common words and punctuation

Examples:

Common terms like a and the are called stop words
and are usually ignored. Punctuation is also typically
ignored. But there are exceptions. Common words and
punctuation marks should be used when searching for a
specific phrase inside quotes. There are cases when
common words like the are significant. For instance,
Raven and The Raven return entirely different results.
5: Capitalisation
Most search engines do not distinguish between
uppercase and lowercase, even within quotation marks.
The following are all equivalent:
•

technology

•

Technology

•

TECHNOLOGY

•

“technology”

•

“Technology”

•

Visual Basic statement case

•

Visual Basic statement for

•

Visual Basic call

8: Customise your searches
There are several other less well known ways to limit
the number of results returned and reduce your search
time:
•

The plus operator (+): As mentioned above,
stop words are typically ignored by the search
engine.

Continued Page 6
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More Efficient Internet Searching – Bill Maxwell
Continued from page 5
•

The plus operator tells the search engine to
include those words in the result set. Example:
tall +and short will return results that include
the word and.

•

The tide operator (~): Include a tilde in front
of a word to return results that include
synonyms. The tilde 2598 operator does not
work well for all terms and sometimes not at
all. A search for ~CSS includes the synonym
style and returns fashion related style pages –
not exactly what someone searching for CSS
wants. Examples: ~HTML to get results for
HTML with synonyms; ~HTML -HTML to get
synonyms only for HTML.

•

•

The wildcard operator (*): Google calls it
the fill in the blank operator. For example,
amusement * will return pages with
amusement and any other term(s) the Google
search engine deems relevant. You can’t use
wildcards for parts of words. So for example,
amusement p* is invalid.
The OR operator (OR) or (|): Use this
operator to return results with either of two
terms. For example happy joy will return pages
with both happy and joy, while happy | joy will
return pages with either happy or joy.

•

Numeric ranges: You can refine searches that
use numeric terms by returning a specific
range, but you must supply the unit of
measurement. Examples: Windows XP
2003..2005, PC $700 $800.

•

Site search: Many Web sites have their own
site search feature, but you may find that
Google site search will return more pages.
When doing research, it’s best to go directly to
the source, and site search is a great way to do
that. Example: site:www.intel.com rapid
storage technology.

•

•

Related sites: For example, related:
www.youtube.com can be used to find sites
similar to YouTube.

•

Forums-only search: Under the Google logo
on the left side of the search result page, click
More | Discussions or go to Google Groups.
Forums are great places to look for solutions to
technical problems.

•

Advanced searches: Click the Advanced
Search button by the search box on the Google
start or results page to refine your search by
date, country, amount, language, or other
criteria.

•

Wonder Wheel: The Google Wonder Wheel
can visually assist you as you refine your search
from general to specific. Here’s how to use this
tool:

1. Click on More Search Tools | Wonder Wheel in
the lower-left section of the screen to load the
Wonder Wheel page.
2. Click on dbms tutorial
Google now displays two wheels showing the DBMS and
dbms tutorial Wonder Wheels, with the results for dbms
tutorial on the right side of the page. You can continue
drilling down the tree to further narrow your search.
Click the Close button at the top of the results to
remove the Wonder Wheel(s).
9: Use browser history
Many times, I will be researching an item and scanning
through dozens of pages when I suddenly remember
something I had originally dismissed as being
irrelevant. How do you quickly go back to that Web
site? You can try to remember the exact words used for
the search and then scan the results for the right site,
but there is an easier way. If you can remember the
general date and time of the search you can look
through the browser history to find the Web page.
10: Set a time limit — then change tactics
Sometimes, you never can find what you are looking
for. Start an internal clock, and when a certain amount
of time has elapsed without results, stop beating your
head against the wall. It’s time to try something else:

Change
your
preferences:
Search
preferences can be set globally by clicking on
the gear icon in the upper-right corner and
selecting Search Settings. I like to change the
Number Of Results option to 100 to reduce
total search time.

Page 6

•

Use a different search engine, like Yahoo!, Bing,
Startpage, or Lycos.

•

Ask a peer.

•

Call support.

•

Ask a question in the appropriate forum.

•

Use search experts who can find the answer for
you.
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Training Session 3 - Macintosh Finder Features – Ian Stringer
Finder: Click on File on the Finder menu bar. Open a
New Finder Window in column mode. The
Keyboard Shortcut is Command+N (⌘N). Click on
the red button to Close Window. The Keyboard
Shortcut is ⌘W. Very useful. The yellow button will
minimise the window into the Dock but leave it active.
The green button will resize the window and acts as a
toggle. You can change the size of any window by
clicking and dragging the diagonal triangle on the
bottom right hand corner.
The Window Title Bar shows the title of the active
Folder. Click on the elongated button on the top RH
end to ‘minimise’ this bar. This can be useful when you
want more screen height. Study what you get when you
do this. Click again to undo. The bottom of this window
gives information about the number of items and the
amount of Hard Disk space available.
Finder Preferences: Press ⌘, (Command+comma)
to open Finder Preferences. You will get a new
window with four icons along the top of its Window
Title Bar. Click on General. These options allow you
to chose what you see on the Desktop (so you don’t
need to have your Hard disk icon in the top right-hand
corner of your screen); New Finder windows open:
lets you select what you want to see in the second
(white) column. Mine is set to Documents. Springloaded folders and windows will open if you hover
your cursor over a folder for a short time. Can be useful
for putting things away in their correct folders.
The second icon called Labels allows you to highlight
any file or folder with a colour. This can be used to find
files more quickly. I don’t use them much.
The third icon called Sidebar allows you to select what
you want to see in the Sidebar. You can tick and untick just what you want. (Have a look at what I use; I
like to keep it simple.)
The fourth icon called Advanced lets you select what
actions you want. You may be used to .DOC file
extensions for Microsoft Word files; we can safely hide
file extensions on the Mac. You can select what you
want searched using When performing a search:.
Often you want to Search the Current Folder. Close
this window.
File: We often want to create a New Folder, usually
inside an existing, highlighted Folder. The Keyboard
Shortcut is Shift⌘N. The title of the new Folder is
untitled folder, and is light blue; you don’t need to
move the cursor to this blue space, you just type in the
name you want.

Have a look at the other File options; there are many
options depending on what you have selected. Close
Window (⌘W) does the same as clicking the red
button. Get Info (⌘I) is very useful; it gives important
information about the selected folder/file. Move to
Trash (⌘Delete) is also very useful, easier than
dragging to the Trash. Note you can also select a
Label: colour from this drop-down menu. There are
usually 2-3 different ways of doing things on a Mac.
Edit: Look at the Edit drop down menu and its
Keyboard Shortcuts. These six shortcuts are very
useful, particularly while your hands are on the
keyboard. Show Clipboard holds the last selection
deleted or copied, while Special Characters... opens
a toolbox of fonts.
View: The first four items in the View drop down
menu replicate the choices in the Toolbar. Clean Up
will tidy up your desktop by moving icons, etc., onto a
grid; while Arrange By allows you to chose how your
folders/files are displayed. Once you have selected a
folder, click on Show Path Bar, and note the strip
across the bottom of the active window. You can also
Show/Hide Sidebar. When more adventuresome, you
can Customise Toolbar... with extra choices. Click on
Show View Options to open a window that allows
you to choose more ways of customising your
computer.
Go: I haven’t used items on the Go drop down menu; I
should have another look.
Window: Minimise (⌘M) does the same as clicking a
yellow button while Zoom does the same as the green
button. The bottom of this drop down menu lists the
currently selected files.
Help: The Help drop-down menu contains a large
amount of information specific to the current
Application (Finder is also an Application). You can
find information on almost any aspect of your Mac
using this Help resource. If you are on the Internet,
there is even more help available, including How-to
videos.
Previous Articles:
Training Session 1 - Macintosh ‘Finder’ was published in
Bits’&‘Bytes March 2011
Training Session 2 - Macintosh Finder Features was
published in Bits’&‘Bytes April 2011
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Technician's Diary – Peter Dodwell
Ipv6 is coming - World IPv6 day, scheduled
for 8 June 2011

http://www.firefoxfacts.com/2009/07/01/firefox-privatebrowsing-mode-help-and-faq/
Another reason to use Firefox.

So what's IPv6?
Well, it's a
replacement for the current way of
identifying internet addresses. The
current system is called Ipv4,
where a web address is expressed
as a sequence of four groups of up
to three numbers separated by dots – e.g.
192.168.45.197 or similar. When you type in a web
address such as www.wotsitname.com or whatever,
the system checks the internet directory for the correct
address so that your browser can take you there.
When you're connected to the internet, you are
assigned a similar return address so that whatever you
ask for will be sent to the right computer.
The problem is that the current system is limited so
that the number of possible addresses is running out.
Hence the change to IPv6 which allows for vastly more
internet addresses. A typical example of an IPv6
address is:
2001:0db8:85a3:0000:0000:8a2e:0370:7334 .
Generally you won't have to worry about this because
the system will take care of address translation. But!
You will need to be aware that older modems and other
equipment won't be compatible. If you're in the market
for new equipment, then you need to ensure that what
you buy will be compatible, because not all new devices
are.
World IPv6 day has been organised so that all may be
able to check their readiness. Go to this web site to
check out your own system http://testipv6.com/ipv6day.html If you're running 'NoScript' then
you'll need to allow the site to run scripts. Info re world
IPv6 day can be found by clicking the appropriate tab.
Further info re IPv6 can be found here http://en.wikipedia.org/wiki/IPv6

Fukushima, and Safe Radiation Levels Peter Daley
Continued from page 4
As far as I can see in Australia at present, the fallout is
not affecting us, but we may need to keep an eye on
our sources of food where radiation fallout can be
concentrated in foods like milk, meat, and fish.
Particularly if this situation worsens.
“Is it safe to travel to, or use food products from a
certain country?” This may be important to you
depending on your level of concern. The only way to
know is to stay well informed on this dynamically
changing situation. There are lots of links to other sites
from these sources I have provided below that may
Bellmere Weather, this web site provides live local
background radiation readings at Caboolture in
Australia. As of May 2011 there has not been any
increased local background radiation readings since the
Fukushima disaster. Maximums of 40 CPM (Counts Per
Minute) and 0.40 uSv/hr (micro sieverts per hour) have
been normal for the local area. If you are looking at
background Radiation readings at other localities, above
100 CPM or 1.20 uSv/hr would be considered elevated
for most areas throughout the world, and should be
avoided. Background Radiation readings I have seen
from other locations around the world that you would
probably visit at present, have not gone above 0.40
uSv/hr on most days.
http://www.bellmereweather.net/geiger.asp

Nevercookie the 'Evercookie' muncher
I mentioned 'Evercookies' last month. The new Firefox
plug in to foil these nasties can be downloaded from
here - http://nevercookie.anonymizer.com/
When
Anonymizer Nevercookie is engaged along with Firefox’s
private browsing mode, it quarantines an Evercookie
and removes it after the browsing session. Firefox 3.5
and later includes the Private Browsing feature which
allows you to browse the Internet without saving any
information about which sites and pages you’ve visited.
Enter 'pbm' from the Firefox 'tools' menu. More info
here -

Fairewinds Update on Fukushima, go through the
previous videos here to get a clearer understanding on
what is happening.
http://www.fairewinds.com/updates
Enenews this site provides up to date info that you
are not getting from normal news sources, read the
previous posts, and comments under relevant press
releases.
http://enenews.com/
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Fun and Games with the dd Command - Colin Jones
The command line has many applications for burning
data CDs or DVDs. But before you can actually burn a
disk, you first need to create an ISO image. ISO (or ISO
9660, to use the full name) is the standard file system
for managing files on CDs or DVDs.
Convert and Copy
The practical dd tool should be called cc, for convert
and copy. However, because this name had been
assigned to the C compiler the developers just went
for the next letter in the alphabet.
The dd command creates 1:1 copies of media,
whether they are hard disks partitions, CDs or DVDs.
Further, dd supports reliable, block-wise reading and
writing operations. Because dd does not process or
interpret these blocks, the underlying file system is not
important. In fact, dd is not fazed by hard discs with
errors. More about this later.
The basic command is:

dd if=source of=target
The if option lets you tell dd where to read the source
data, and the of option defines the output.
The source and target are devices such as hard disk
partitions or CD/DVD drives. As an alternative , you
can use an equals sign to point to a file. To copy the
hard drive partition /dev/hda1 bit for bit to /dev/hdb1.
You would type:

dd if=/dev/hda1 of=/dev/hdb1
Also, you can use dd to copy a CD or DVD quickly in
the shell. To create an ISO image, for example, type
the following command:

$ dd if=/dev/sr0 of=myimage.iso
193232+0 records in

By default, dd uses 512-byte blocks – reads 512 bytes
at a time and writes them to the output file. If you
select a larger block size, you can speed up this
process up, for example, by typing the following:

dd if=/dev/hda1 of=/dev/hdb1 bs=2k
This command tells dd to copy the partition in blocks
of 2KB (2048 bytes). If the last block is smaller than
the specified block size, dd will not pad it:

$ dd if=/dev/hda1 of=/dev/hdb1bs=6k
16059+1 records in
16059+1 records out
98670952 bytes (95 MB) copied
13.801482 s,
6.9MB/s
The output tells you that dd has copied 16059 blocks
of 6144 bytes each with one remaining block of 4096
bytes.
Besides block size, you can specify how many blocks
dd reads. To copy 40 MB, just write bs=1M count=40.
The count option specifies the number of blocks. This
makes sense if you want to save a hard disk boot
sector – you would just copy the first 512 – byte
block:

dd if=/dev/hda of=bootsector bs=512 count=1
As referred to earlier, dd is not fazed by hard disks
with errors. Thence, the command becomes an
essential tool when faced with the daunting task of
rescuing data from damage systems. Before you repair
the damage, first create a back up copy. To do so, use
dd to create 1:1 copy of the damaged system. Then
use the copy for your rescue attempt.
Because dd excludes defective sectors from the copy
by default, you need to enable the conv=noerror.sync
option.

193232+0 records out
98934784 bytes (99 MB) copied, 56.9568 s, 1.7 MB/s
When using dd there is no need to mount the
medium to perform a quick copy. In the example
shown, just replace the /dev/sr0 drive designator with
the device name for your drive. The ISO image is
written to a file called myimage.iso in the current
directory.

dd bs=512 conv=noerror.sync if=dev/hda
of=/dev/hdb
which tells dd to continue reading and storing data,
even if it is discovers defective sectors. The noerror tag
tells dd not to stop on errors, and sync pads unreadable
sectors with zeros.

Optimizing Options
The command dd
has a number of flags. One
practical parameter that speeds up the program
considerably is bs (for block-size).
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Going Digital – Ted Webber (Continued from April)
Recording with an external USB flash or
Hard Drive

to record and has nothing to do with an alarm,
although it could be used as such no doubt.

With an external USB flash or hard drive connected,
you first need to configure it according to “10.3 PVR
Configuration”. The Record Type option is interesting for
those who are hard of hearing, because when recording
sub-titled programs in the analogue system the subtitles are lost. The TS option in the STB, however,
records sub-titles. Unfortunately, the resulting DVR
format can be played back only in the STB. I searched
the internet for a suitable format converter and found
one called DVR-MS to MP4 but it did not work in this
case.

Playback
The manual has nothing to say about playing a
recording. Just go to Media -> PVR Manage, select the
recording you want to watch and press OK. It can be
fast-forwarded over commercials, paused while you
make the coffee or skipped to the next recording just as
on a VCR or PVR.

Simple recording from the present time for up to 2
hours (default) is achieved by pressing the red dot
record button on the remote. For time-shifting, follow
the instructions in the manual.
More useful is the facility to record a future program or
programs. This operation needs some experimentation
to achieve success, and appears to be unnecessarily
complicated!
From the Main Menu, select Setup then Timer as at top
of p. 10 of manual “7. Timer” and follow the
instructions there. “Timer Number” does not advance
automatically, so it is best to keep a written list of what
you have recorded, and this will tell you what is the
next number in the sequence. Numbers available are
limited to 1 – 8, but reusing a previous number does
not cause it to be overwritten. You can also refer to
Media->PVR Manage to check this, but note that the
title of each recording there is derived from what was
on at the moment of starting the recording, and this
may be the tail end of the previous program, not the
one intended.
“Timer Mode” allows you to specify (say) weekly
recording of the same program at the same time.
Otherwise, set it to “Once”.
Next, set the date and start time of the program to be
recorded, set “Auto Record” on, and enter the duration
of the program to the nearest minute, perhaps allowing
a few extra minutes in case of overrun.
When setting the date or time, use the up/down arrows
on the remote to select the item, then press OK before
trying to change a digit, which can be done with the
up/down arrows or by entering the digit.
The “Wakeup Channel” refers to the channel you want
Page 10

May 2011

Bits'N'Bytes

Jeans Jottings
Open Office Writer – Generating a Block of Text
There a simple way to generate a paragraph of random
text in Open Office Writer other than using the
Extension 'Lorem Ipsum' .
In an Open Office Writer document enter the letters
"dt" - (dummy text) without the quotes and click the F3
key and a block of text is inserted. The difference with
this method and Lorem Ipsum text is that this method
gives readable text whilst Lorem Ipsum makes dummy
text. It is claimed that a reader is distracted by the
readable content of a page when looking at its layout.
The font type and font size can be set before typing in
the “dt” and the insertion will be in that font and size.

Australian Seniors Computer Clubs
Association (ASCC Newsletter
The Sunshine Coast Computer Club Inc is a member of
the Australian Seniors Computer Clubs Association –
(ASCCA).
ASCCA issues a Monthly Newsletter, The May 2011
Newsletter may be viewed at - http://www.ascca.org.au
(Click on ASCCA's latest newsletter) or a hard copy is
available for reading at the Caloundra, Buderim and
Yandina Meetings during the month of May 2011.

Its time to think about the ASCCA
Competitions

Open Office Calc (Spreadsheet) Print Grid Line
with no Input
It is possible to print the lines showing rows and
columns on a blank spreadsheet. One way is to open a
new Calc (Spreadsheet) and go into Format > Page >
Sheet > Tick against Grid in the Print list and click OK.
Then put a space in the top left hand cell and the
bottom right hand cells of the sheet by placing the
cursor in the cell and moving the space bar once or
twice to give it something to print. Do a Print Preview
before printing to be sure what is done is correct.

All entries must be received prior to 4.00 pm on Friday
16th September, 2011.
Late entries cannot be accepted.
Winning entries will be announced at the ASCCA
Annual General Meeting on Thursday 17th November,
2011.

The Sections Are:

Open Office – Get rid of grey bars in copied work

Creative Writing

At times when something is copied from a web site or
one programme to another (e.g. MS Works to Open
Office) there will be grey bars/marks either like a
single stroke or a number of them joined as a block
or a whole line throughout the copy. This is one
way to get rid of them in Open Office.

Photo Slide Story

Highlight and copy one of them (Ctrl + C) or (Edit >
Copy) Next bring up the Find and Replace Window
(Ctrl + F) or (Edit > Find and Replace) With the cursor
in the 'Search for' line of this Window > Paste in the
copied grey bar (using either Ctrl + V or Edit > Paste)
You may not see anything in this line after the paste is
done. Left Click on Find All, then next click on Replace
All.

Digital Photography
Club Website
Try out the new skills you've learnt and send off an
entry.

If the magic works they should all be gone.
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Raffle
The last SCCC Raffle was drawn using the Random Number Generator at the Buderim Meeting on Wednesday
20th April 2011
The prize was a Blackberry Pearl 9100 Smartphone. This is one of those telephones that will do
everything you want and more. You can send e mail and text messages, use it for video recording,
as a media player, browser, for instant messaging, listening to music for up to thirty hours and of
course chat and much more.
The lucky winner with ticket number 451 was Lindsay robe who bought the ticket at a Buderim
meeting.
Thank you to the members who supported this raffle and to the members manning the desks and
selling tickets in the raffle.
Remember that if you have any suggestions for prizes for future raffles please email the Club at sccc@internode.on.net - or talk to the door persons at a meeting or to a member of the Committee.

RAFFLE TO BE DRAWN SATURDAY 21 MAY 2011 at CALOUNDRA
Would you like to have three hundred dollars to spend on
whatever you would like for yourself? This is what is waiting for
the winner of the Raffle to be drawn at Caloundra on Sat 21 May.
The prize for this raffle is a voucher for three hundred dollars
which can be exchanged for cash.
Tickets are one dollar each and available at all Club
Meetings until the day of the draw.
Remember buying of tickets is voluntary

RAFFLE TO BE DRAWN WEDNESDAY 25 June 2011 at Buderim
The Raffle to be drawn on 25 June 11 at the Caloundra
Meeting has a prize that will have members asking if they
can have the winning ticket. It is one of the latest Tom
Tom GPS (Global Positioning System) – Model VIA 180
devices.
The TomTom Via makes navigation a breeze,
putting you firmly in the driving seat. Designed for
convenience, it also lets you use your voice for many
different tasks, such as entering addresses and making
calls hands-free. Navigate complex junctions with ease
using advanced lane guidance. Get accurate arrival times
through IQ Routes on top of the very best maps.
Tickets are one dollar each and available at all meetings from 25 May to 25 Jun 11. Buying of
raffle tickets is voluntary.
Remember buying of tickets is voluntary
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Corporate Members
Help with Computers

Peter Daley

Andrew Hadland Diploma ICT
Phone 5491 8645
•
•
•
•
•

Help with all aspects of Computer
Functions
Tuition – Emails – Scanning – Video
Editing
Burning CD's / DVD's – Backups
Protection Anti Virus – Spyware – Firewall
Internet – ADSL Setup

Computer Repairs and Upgrades for
Windows and Linux. Data Recovery,
Computer and Internet Training and Setup.
Home Entertainment and Hi Fi systems
setups and advice. Custom built computers,
all computer systems are tested before
pickup. Award Winning Web Page Designer!
E-mail: ( Peter Daley)...

PH 0754913279
| Free Books | | Links | | E-mail |

Computer - Repairs - New Systems

Welfare Officer
Sunshine Coast Computer Club
Phone 54925443 Email gregalach54@gmail.com
If you are ill or incapacitated or know of a club
member who needs some assistance or would
like to hear from the Club
contact our Welfare Officer Marie McGregor

Find Your Membership Number
Do you read your Bits'N'Bytes each month? Find your membership
number hidden somewhere in one of the pages and win five free tickets
in the current raffle.
The membership number will be chosen at random and will appear as a
four digit number within the text of the magazine and may be on any
page. If your membership number has 1, 2 or 3 digits, it will be shown
with leading 0s.
Do not forget to thoroughly scrutinise every magazine for your membership number hidden within the text of
articles each month.
The number is placed in the 8672 middle of a sentence like this!
Start looking now! The lucky membership number is hidden somewhere in this month's edition. Is it yours?
When you find your number contact the club by email at editor@sccc.org.au or phone 54921005 to claim your
prize. You are allowed 60 days from the publication date to claim your prize. Otherwise, the prize is forfeited!
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Classified Ads
Classified Advertisements in Bits'N'Bytes - Editorial Policy is that B'N'B Classified Advertisement 1. Are for the use of members only.
2. Items must not be of a business or commercial nature.
3. Items submitted should be limited to a few items - no huge garage sale lists please!
4. Items should preferably be relevant to computers, graphics, video, audio, electrical or electronic hobbies
etc. Adverts for other types of household goods will be accepted only if there is sufficient room for them.
5. Ads should preferably be forwarded direct to editor@sccc.org.au or phoned in to 54913279.
6. The Editor reserves the right to reject or edit any material .Editor reserves the right to reject or edit

FOR HIRE OR LOAN
The Sunshine Coast Computer Club owns data
projectors, laptops, external DVD burners, scanners,
digital cameras, etc.
This equipment is available for hire or loan to members
when it is not required by the club for meetings and
presentations.
Contact your club if you need to borrow or hire
equipment.

VIEW SLIDE SHOW

Portable TV with VHS and DVD included

Email: sccc@sccc.org.au

$50 O.N.O.

Telephone: 0754921005

Ph 07 5456 2927 (Buderim)

BILLION WIRELESS ROUTER
WITH VOIP
BIPAC 7401VP / VGP-M

FOR SALE
New Uniden Laser PICO Projector ULP 1000
Includes VGA dock
The projector uses laser technology to create an
image that’s sharp and colourful.
The projector is new and has never been used.
$300
Phone Edgar 5491 6611

Rarely used new wireless router with V.O.I.P.
Cost $150 sell $70
Ph 07 5456 2927 (Buderim)

Place Your Classified Ad on this page.
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Item (Prices include GST)

Number

Bits'N'Bytes Ezine Archives CD - June 1998 to December 2009.
Bits'N'Bytes Ezine Archives CD – trade in your old copy.

@ $10 each
@ $5 each

Multimedia CD - Clip Art, Animations, Midi and Wav files and
background colours to add to cards, emails etc. Multimedia CD
Upgrade (With old version CD returned)

@$10 each
@ $5 each

Postage (for one or more CDs)

Cost

$3.00

Post to : SCCC, Post Office Box 384, Caloundra
Enclosed
Cheque / Money Order / Cash

4551
Total

Surf Watch - Members Web Sites...Submit Yours

Member
Peter Daley

Very Useful Links
http://www.ozemail.com.au/~vital1/lstlinks.htm

Peter Daley

Fantasyland Creations http://www.ozemail.com.au/~vital1/

Peter Daley

Daley Positive Personal Development
http://www.ozemail.com.au/~vital1/freebks.htm

Jay Leboutillier

Website Design Centre http://www.websitedesigncentre.com.au/

Technologypals

Corporate member http://www.technologypals.com.au

Bill Maxwell

IT Knowledge Base for Seniors http://it.flexinet.com.au/

Your Committee
President

Peter Daley

5491 3279 (VOIP)09134402

Vice President

Heather Atkinson

5444 0886 (VOIP) 09110928

Secretary

Marie McGregor

5492 5443

Treasurer

Leo Kavanagh

5492 1786

Administration Co-ordinator

Jean Lear

5492 1151

Committee

Tom Bray

5479 3149

Committee

Morry Phillips

5491 1148

Committee

George Lupsa

5445 3850

Committee

Jim McGregor

5492 5443

Committee

Ian Smyth

5491 9139

Committee

Andrew Hadland

5491 8645

Committee

Don Wallace

0401 093 692

Committee

Peter Dodwell

5438 7675

Club Intranet
The Club Intranet is available at all meeting venues. It is packed with up to date free software, tutorials and back
issues of Bits'N'Bytes. Access it from any networked computer at the venue.
Type In your browser address bar:192.168.2.222 At both Buderim and Caloundra and Yandina when
available.
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SCCC Membership Application/Renewal Form
Applications can be posted to SCCC Inc., P O Box 384, Caloundra, 4551
or presented at a meeting
I wish to apply for membership
I wish to renew my membership

Name(s):

Address:
City:

Postcode:

Phone:
Email:
I will collect my membership card from Caloundra

Buderim

Yandina

Membership fees include the electronic version of the club
magazine.

Amount

Individual

$35

Family

$45

Corporate (Includes a monthly advertisement in the club magazine)

$60

Junior (Under 18 Years of Age)

$20

For the additional cost of $12 you may subscribe to a printed and posted
paper version of the club magazine.
Magazine subscription

$12
Total Enclosed $

Signature:
If after joining you don't receive your magazine within one month,
please contact the Club.
SCCC Office Use
Date Paid:

Amount: $

Receipt Number:

Membership Number:

Signed:

Nominated:
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